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1. Важная информация
Благодарим Вас за покупку нашего режущий плоттер.
Перед использованием режущего плоттера, пожалуйста, ознакомьтесь с 
мерами безопасности и инструкциями ниже.

Примечания, предостережения и предупреждения

Примечание: Содержит важную информацию, которая помогает более эффективно 
работать с режущим плоттером

Предостережение: Указывает на потенциальную опасность повреждения плоттера 
или потери данных и объясняет, как избежать проблем.

Предупреждение: указывает на потенциальную опасность повреждения плоттера, 
имущества или возможность получения травм.

ПРЕДУПРЕЖДЕНИЯ!

Не разбирать и не переделывать плоттер:

• Разборка может привести к поражению электрическим
током или к повреждению плоттера

Исключить контакт в водой (влажной средой):

• Не используйте плоттер во влажном помещении
• Не используйте плоттер под открытым небом,

исключите любое воздействие на плоттер воды и
пара, во избежание замыкания и пожара.

Выключать в экстренных случаях: 

• При появлении нехарактерного шума, запаха, или
дыма и прочих нетипичных признаков, необходимо
срочно отключить плоттер от электросети, во
избежание пожара и порчи имущества. Убедившись в
отсутствии признаков возгорания, нужно обратиться в
сервисный центр.

• Самостоятельный ремонт плоттера может
быть опасен для вас.
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Электробезопасность:

Необходимо использовать электросеть с заземлением. 
Необходимо использовать стабилизатор напряжения, во 
избежание повреждения плоттера при перепадах 
напряжения в сети. Необходимо использовать кабель, 
вхдящий в комплект и не допускать его повреждения.

ВНИМАНИЕ!

Особенности размещения плоттера в помещении:

• Не размещайте плоттер под прямыми солнечными лучами.
• Не размещайте плоттер на неровной или наклонной поверхности.
• Не размещайте плоттер в помещении с резким перепадом температуры и

влажности. Рекомендуемые показатели темпетаруры от 18 до 35 градусов С.
Влажность - от 35 до 65%.

• Не размещайте плоттер на вибрирующей поверхности.
• Не размещайте плоттер в местах, подверженных воздействию ветра и воды.
• Не размещайте плоттер возле источников тепла (приборы отопления, камины).

О режущем инструменте плоттера:

• Не прикасайтесь к лезвиям ножей плоттера, они острые!
• Не трясите и не качайте держатель ножа, лезвие может оторваться.

Безопасность при работе:

• Будьте осторожны при работе плоттера. Не допускайте попадания в плоттер
конечностей (пальцев рук), элементов одежды, волос и посторонних предметов

Качество обрабатываемого материала:

• Не рекомендуется использовать материал с загибами и иными дефектами,
так как это влияет на качество резки.

Всегда устанавливайте прижимные ролики на красные отметки

Не используйте в домашних условиях для безопасности детей

Используйте сетевую розетку с заземлением и стабилизатор 
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2 . Основная информация.

2.1 Введение
Плоттеры предназначены для нанесения графических рисунков на рулонные 
материалы, а также, для контурной резки рулонных виниловых пленок. Настоящее 
руководство предназначено для плоттеров серии R и S:
Plotter R/Plotter S модель 1180: минимальная ширина рулона 50 мм; максимальная 
ширина рулона - 1180 мм.
Plotter R/Plotter S модель 1300: минимальная ширина рулона 50 мм; максимальная 
ширина рулона - 1270 мм.

2.2 Комплектация

�

Номер Наименование Количество Примечание

1 Гарантийный талон 1
2 Силовой кабель 1
3 USB кабель 1
4 СOM порт 1
5 Держатель ножа 1
6 Нож 3
7 Рейсфедер 1

8 Компакт-диск CD 1

инструкция ,FTDI_USB Driver,Artcut
driver,AutoCAD plugin,
CorelDraw_Plugin
5.0,PDF reader,Scale Calculator

9 Мобильный стенд 1

10 болт M5*45 16

11 болт M5*8 8

12 болт M4*8 12

13 Шайба 16

Крепежные элементы и подставка
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2.3 Описание

2.3.1 Внешний вид

1 

2 

3 

4 

5 

6 

7 

Стальной вал
Держатель рулона 
Выключатель питания 
Прижимной ролик

8 

Плоттерная головка
Разъем питания
Панель управления
Мобильный стенд 
(подставка)

2.3.2 Вид 
сбоку

2 Выключатель 
4 USB порт

1 Разъем питания 
3 СОM порт
5 USB разъем

2.3.3 Панель управления

1 Индикатор питания 
4 Координаты по оси Y 
7 Меню

2 световой индикатор 
5 Вправо по оси Х
8 Ввод

3 индикатор тока 
6  Вперед  (Y)
9 Пауза

12 Ввод
15 Вперед по оси Y
18 Повтор резки

21 Тест
24 Обратно по оси Y

10  Меню
13  Обнуление
16  Влево по оси Х
19  Пауза
22  Повтор резки
25  Влево по оси Х

11 Тест
14 Вправо по оси Х  
17 Обратно по оси Y 
20 Кнопка сброса 
23 Обнуление
26 Координаты по оси Х
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3. Сборка плоттера
3.1 Мобильный стенд (сборка)

Внимание: необходимо использовать болты M5*45

Необходимо использовать болты M4*8 для крепления плоттера на стенд.

3.2 Подключение плоттера

3.2.1 Подключение сетевого кабеля

Подключите кабель питания к разъему питания на плоттере и к электрической розетке.

3.2.2 Подключение USB

Если вы хотите использовать кабель USB, необходимо установить драйвер USB.

1.Вставьте компакт-диск, входящий в комплект и подключите USB кабель к плоттеру 
и компьютеру. Компьютер обнаружит новое оборудование, как показано ниже:
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2.Нажмите "Next", компьютер будет искать компакт-диск для драйверов USB
автоматически
3.Дождитесь завершения автоматической установки системы 

4. Нажмите кнопку "CLOSE”

5.Если драйвер был успешно установлен, вы можете найти новый порт в
диспетчере устройств, как показано ниже:
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В случае, когда 
автоматический поиск и 
установка драйверов не 
запускаются, в приложении А 
приведен способ ручной 
установки драйвера.

Если вы хотите изменить 
номер порта по умолчанию 
драйвера USB, нажмите 
правой кнопкой порт (COM3), 
как показано выше, и 
выберите "Свойства" в 
контекстном меню. Затем 
установите "бит в секунду" и 
"Управление потоком", как 
показано ниже:

Затем выбирете “Дополнительно…”, в окне следующего вида 
установите настройки как показано:
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Выберите номер порта, то, что вы хотите изменить, а затем нажмите “OK”
ВНИМАНИЕ: "бит в секунду" должно быть установлено как "38400"

3.2.3 Подключение кабеля RS-232 (com-port)
Если вы хотите подключить RS-232C кабель, необходимо соблюдать следующие указания

Примечание: 
(1) Подключать кабель следует только при выключенном из розетки плоттере и при 
выключенном компьютере.
(2) Не подключайте и не отключайте кабель при передаче данных во время работы.

12 

или  в окне другого 
вида, следующим 
образом:
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3.3 Установка режущего инструмента

На рисунках 3-1 и 3-2 изображен держатель для ножа

Рисунок 3-2: Схема разборкиРисунок 3-1: Как установить нож

(1) Открутите защитный колпачок с держателя для ножа.
(2) Вставить нож в посадочное гнездо.
(3) Наденьте защитный колпачок и начинайте его закручивать ровно до тех пор, пока в 
нижней части его основания не появиться острие ножа. После этого зафиксируйте 
положение ножа сверху стопорным кольцом.

Правильное положение ножа
Base paper - подложка 
пленки, Film - пленка. 

Нож выставлен недостаточно Нож слишком выставлен 

Примечание: Выступ ножа должен быть равен толщине обрабатываемой пленки. В 
этом случае нож прорежет пленку, не затронув подложку.

3.4 Установка держателя для ножа
Встравьте держатель для ножа в посадочное гнездо на режущей головке плоттера и 
надавите на него, он плотно встанет в гнездо. Затем зафиксируйте держатель 
прижимным болтом.

Примечание: Держатель для ножа должен быть плотно зафиксирован, иначе 
пострадает качество обработки пленки.
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3.5  Заправка материала
В плоттер может быть загружен целый рулон пленки или его часть.

Рисунок 3-3 Рисунок 3-4 
(1) Поднимите вверх рычаг прижимных роликов (см. Рисунок 3-3)
(2) Разместите материал лицевой или обратной стороной под прижимные ролики. 
(3) Установите прижимные ролики вручную в соответствующее положение. Убедитесь, 
что прижимные ролики должны быть расположенным над стальной осью.Красные метки
помогуи Вам определить положение стальной оси.
(4) Опустите вниз рычаг прижимных роликов (См. рисунок 3-4), чтобы закрепить 
материал.

ВНИМАНИЕ: при перемещении прижимного ролика, нужно перемещать его, 

использую заднюю часть, а не резиновую часть (прижимной валик), иначе 

прижимной ролик может быть поврежден.

4. Основные операции

4.1 Подбор давления ножа
Это поможет вам определить правильную величину  давления ножа на пленку.

Примечание: Когда нож изношен и затуплен, вы можете использовать его  
временно, осуществляя резку путем повышения давления ножа. Тем не менее, 
рекомендуется, своевременно заменять изношенные ножи новыми, чтобы  
обеспечить удовлетворительное качество резки. 

Нажмите или Плоттер вырежет квадратик. Если вы легко можете отделить

тестовый квадрат от основы пленки, значит установлено оптимальное давление ножа. 
Если квадрат не прорезан - давления не достаточно. Если прорезана основа виниловой 
пленки - давление избыточное.
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4.2 Давление и скорость

(1)Нажмите для перехода к интерфейсу

в котором F100 - это давление，V500 - это скорость.
(2) 

Pressure
(давление) 

или Уменьшение давления
Шаг 5 грамм 
Мin давление 5 грамм

или Увеличение давления
Шаг 5 грамм
Max: 500 (R)/1000 (S)

Speed
(скорость)

или Уменьшение скорости
Шаг 25 мм/сек
Min скорость 50мм/сек

или Увеличение скорости
Шаг 25 мм/сек
Max: 500 (R)/1000 (S)

или чтобы сохранить параметры давления и скорости.

4.3 Языки и скорость передачи данных

(1) Нажмите или для перехода к интерфейсу

Language
(язык)

или 
Переключение между 
китайским и английскимили 

Скорость передачи или Переключение между 
38400 и 56000

или

(3) Нажмите

(2) 
или 

(3) Нажмите или чтобы сохранить параметры настройки.

ПРИМЕЧАНИЕ: Убедитесь в том, что скорость передачи данных плоттера и 
компьютера одинаковые. Внимание! скорость передачи данных должна 
соответствовать  программному обеспечению вашего компьютера.

4.4 Параметры осей Х и У

(1) Нажмите или для перехода к интерфейсу
в котором значение Sх0 - это коэффициент пропорциональности оси X; Sу0 - это 
коэффициент пропорциональности оси Y. По умолчанию установлено значение 0 
(ноль). Если есть ошибки в плоттере, вы можете настроить параметры осей.
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(2) 

Ось X
или Уменьшение параметра по 

оси Х  
Увеличение параметра по 
оси Х

Ось У
или Уменьшение параметра по 

оси У

или Увеличение параметра по 
оси У

(3) Нажмите или , чтобы сохранить настройки.

Примечание: Значение координат осей Х и У зависит от стоящих перед вами задач.

4.5 Расстояние между стержнем и лазерной точкой 

(1) Нажмите или для перехода к интерфейсу

(2) Закрепите лист и держатель стержня. Убедитесь, что стержень оставляет след на 
листе при ручном нажатии на него. Проставьте на листе ТОЧКУ.

(3) Нажмите или для перехода к интерфейсу

(4) Клавиши-стрелки , , , , используйте для перемещения красной точки к 

или

 центру точки, только что сделанной вами стержнем на листе. 

(5) Нажмите или для сохранения настройки.

4.6 Проверка расстояния между стержнем и лазерной точкой 
Данная функция поможет Вам определить точность расстояния.

(1) Нажмите или для перехода к интерфейсу

(2) Закрепите лист и держатель стержня. Проставьте на листе ТОЧКУ.
Красная точка найдет точку на листе автоматически. Если не направлены на

(3)Нажмите точку, он должен быть сброшен.
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4.7 Темы интерфеса LCD и величина шага перемещения

, , , Кнопки непрерывного движения.

, , , величину перемещения можно установить в следующем поле, 
по умолчанию 5,0 мм

(1) Нажмите или для перехода к интерфейсу

(2) 

(3) Нажмите или для сохранения настроек.

4.8 Резка из FLASH памяти плоттера
Плоттер имеет встроенную FLASH память, каждый файл присланный с компьютера будет 
сохранен во встроеннаю FLASH память автоматически. При отключении, файл не будет 
потерян, что дает возможность не отправлять его заново с компьютера.

(1) Нажмите или для перехода к интерфейсу

Темы интерфеса
or Изменяется внешний 

вид LCD, доступны 6 
тем. or 

Расстояние 
движения

or 
Уменьшите расстояние 

движения, ум 0.1mm

or 
Увеличьте расстояние 
движения, макс 100. 0мм.

(2) Нажмите или для продолжения обработки последнего рабочего файла.

4.9 Резка из U диска
Плоттер может вырезать файл с диска U, формат файла должен быть .PLT. 
(1) Скопируйте файл .PLT формата на диск U, Вставьте диск U в плоттер.

(2) Нажмите или для перехода к интерфейсу

(3) Нажмите или для перехода к интерфейсу

(4) Нажав , , , выбирете файл, который вы хотите использовать.

(5) Нажмите или для начала работы.
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4.10 Число повторов резки и оптимальная скорость
Когда вы режете файлы с флэш-диска или U, вы можете установить количество повторов резки

(1) Нажмите или для перехода к интерфейсу

Оптимизированное значение Пояснения
0 Резка обычного материала 
1 Резка небольшого рулона материала 
2 Резка большого рулона материала 
3 Резка толстых и жестких материалов (напр., светоотражающей пленки)

4.11 Восстановление заводских настроек по умолчанию

нажмите или , заводские настройки

Число повторов
или Уменьшение числа повторной резки

или Увеличение числа повторной резки

Оптимальное 
значение

или Уменьшение оптимизированного значения 

или Увеличение оптимизированное значение 

ПРИМЕЧАНИЕ: По умолчанию это 1 раз, Макс в 500 раз.

В интерфейсе

будут восстановлены по умолчанию.

4.12 Нож и лазерный тест

В интерфейсе , нажмите или , красная точка будет 

4.13 Пауза или Отмена операции
(1) В процессе операции нажмите или , интерфейс измениться на такой:

или и плоттер продолжит работу.. Затем нажмите

(2) В статусе Паузы нажмите или , будет отменено текущее задание.

и выключаться по очереди, и каретка пойдет вниз и вверх по очереди.
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 4.14 Кнопка обнуления координат

или , разное время он будет В интерфейсе ,нажмите

иметь различных функций, которые описаны ниже:

Время давления Интерфейс Операция Результат

1 

Нажмите кнопку 

или 

Значения Х,У координат 
будут обнулены

2 

Значение координат X,Y 
будет изменено  на 
значение координат 
лазерной точки

3 
Значение координат X,Y 
будет изменено на 
значение координат ножа 

5.Дополнительные операции

5.1 Резка в ПО FlexiSTARTER 
(1)   Установите программное обеспечение.
(2) После завершения установки, запустите Production Manager, нажмите кнопку "Setup" - 
"Add Setup".

(3)  Выберите название модели вашего плоттера, и нажмите кнопку "Next".
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(3)  Выберите название модели вашего плоттера, и нажмите кнопку "Next".

(4) Установите параметры, как показано ниже:

(5) Нажмите кнопку “Finish”.

5.2 Резка из ARTCUT

(1) Нажмите “Device” в окне “Set Engraver/Router’s Output”

ВНИМАНИЕ: выбранный вами порт в Flexi должно быть таким же, как порт в 
«Диспетчер устройств» вашей операционной системы.
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(2) Отобразится окно “Install Sign-maker”.

(3)  Нажмите “From Disk”,

(4) Выбирете “ARTCUT driver” -> файл “Cutter.cfg” .
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(5) Выбирете “Teneth” для 
производителей, выбрать 
подходящую модель для 
модели устройства, и затем 
нажмите "Add".

(6) Укажите номер порта в 
"Serial Port Setting" на странице 
"Настройка устройства", как 
указано ниже:

(7) Теперь вы можете 
использовать программное 
обеспечение Artcut для 
работы.

5.3 Резка из CorelDraw
Ваш плоттер поддерживает вывод резки из CorelDraw, до этого вы должны 
установить плагин для программного обеспечения. Плагин встраивается в CorelDraw 
версий 12, X3, Х4.

5.3.1 Установка плагина

(1) Найти CorelDraw_Plugin 5,0 папку с 

компакт-диска, поставляемого с вашим 

плоттером

Дважды щелкните  на 
кнопку  “setup” чтобы 
установить его.
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Нажмите кнопку “Next”.

Нажмите кнопку “Install.

Нажмите кнопку “Finish” для 
завершения установки.
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(2) Найдите папку 
"CutterPro_5.0.gms" и 
"printer_th" в 
CorelDraw_Plugin 5,0 и 
скопируйте их в папку GMS 
Corel Draw, следуя пути: 
Corel->“CorelGraphics12”-
>“Draw”->“GMS”

(3) Выполнить CorelDraw 
добавить плагин, следующими 
способами: Нажмите  “ Tools”-
> “Customization…” -> 
“Commands”-> “Macros”.

(4) Нажмите “Appearance”->“Import”->“Files…”.  Выберете файл “printer_th.ico” и 
перетащите значок на панель инструментов программного обеспечения CorelDRAW.

Теперь вы можете использовать этот плагин.
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5.3.2 Как пользоваться

(1) Подготовьте файл в CorelDraw

(2) Щелкните по значку на панели инструментов, появится "Экспорт HPGL" диалоговое 
окно.

Выбрать вкладку "Page"  и установите галочки, как показано на рисунке.

Во вкладке “Advanced”, нужно выбрать “millimeters” для резки.

Нажмите “OK”, он будет отображать окно Диалог вывода:
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(3) Выберите соответствующий порт 
и скоростью передачи данных на 
плоттер подключен и установите 
значение острым углом и закрыть. 
Затем нажмите кнопку "Пуск", чтобы 
справится с этой задачей.

ПРИМЕЧАНИЕ: Вы также можете нажать "Сохранить PLT.", Чтобы сохранить файл на 
компьютер, или скопировать его в SD карты или U диск для использования на 
плоттере форума.

5.4 Вывод из AutoCAD
5.4.1 Добавить плоттер

(1) Нажмите в главном 

меню -> “Print” -> “Manage

Plotters”

(2) Отобразится окно “Plotters”, щелкните дважды на “Add-a-Plotter Wizard”.
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(3) Отобразится следующее диалоговое, нажмите “Next”.

(4) Выберете “My Computer”, затем нажмите “Next”.

(5) Выберите "Hewlett-Packard" среди производителей и "Generic SHPGL» для 
моделей, и нажмите  “Next”.
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(6) Нажмите "Next" в 
следующем 
диалоговом окне.

(8) Введите имя для 
плоттера, а затем 
нажмите “Next”.

(7) Выберете “Plot to

File”, и нажмите 
“Next”.

(9) Нажмите “Edit Plotter

Configuration” для 
установки параметров.
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(10) Выберете “Custom Paper

Sizes”, и нажмите “Add…”.

(11) Выберете
“Start from

scratch”, и 
нажмите “Next”.

(12) Введите 
соответствующее значение 
ширины и высоты в 
соответствии с вашим 
плоттером, и нажмите “Next”.

(13) Введите значение пределов области печати, а затем нажмите “Next”.
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(11) Выберете “Start

from scratch”, и 
нажмите “Next”.

(12) Введите 
соответствующее 
значение ширины и 
высоты в 
соответствии с вашим 
плоттером, и нажмите
“Next”.

(13) Введите значение 
пределов области 
печати, а затем 
нажмите “Next”.
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(14) Введите название 
формата, а затем нажмите
“Next”.

(15) Введите Имя PMP-
файла, а затем нажмите
“Next”.

(16) Нажмите кнопку
“Finish”.
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(2) Нажмите в 
главном меню ->
“Print”.

5.4.2 Как вывести

(1) Создайте файл, 
который вы хотите 
вывести.

(3) Выберите плоттер и 
размер бумаги (см. стр 
32-5.4.1), и выберите пункт 
"Plot to file” флажок и 
"Custom" для размеров. 
Затем нажмите кнопку 
“Preview”, если отображается 
не правильно, пожалуйста 
измените параметры, и, 
наконец, нажмите кнопку 
"OK".
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(4) Выберите 
место, где Вы 
хотите сохранить 
файл, введите 
имя файла, а 
затем 
нажмите“Save”.

(5) Запустите 
программу для 
выода из AutoCAD 
на компакт-диске 
плоттера

(6) Выберите 
соответствующий 
порт и скорости,
(7) Нажмите
“Browse…” чтобы 
найти .PLT файл, 
который вы только 
что сохранили.

(8) Нажмите “Start” для резки или нажмите кнопку “Save as…” чтобы сохранить файл на 
карту SD или U диск.
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5.5 Вывод из Adobe Illustrator

ПРИМЕЧАНИЕ: Этот плагин поддерживает только Adobe Illustrator CS4 или 
старше версии.

5.5.1 Установите плагин

(1)  Найти папку Ai_Plugin 5,0  

на компакт-диске:

(2) Найти "CutterAi.aip" в 
Ai_Plugin 5,0 папку, и 
скопируйте его в "Плагины" из 
Adobe Illustrator CS4 следуя 
путем：“Program Files” ->
“Adobe” -> “Adobe Illustrator

CS4” -> “ Plug-ins”: 

Дважды щелкните на значок “setup.exe” file

Нажмите “Next”.
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Нажмите “Install”.

Нажмите “ Finish” для 
завершения установки.

5.5.2 Как пользоваться?

(1) Создайте файл как указано ниже:

(2) Выберете текст，и нажмите “Type”-> “Create Outlines”:
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Появиться окно, как 
показано ниже:

(3)  Нажмите “File”-> “To Teneth Cutter…”:
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Тогда у вас появится окно:

, После этого он будет отображать 
окно Диалог вывода

(4) Выберите соответствующий порт и скоростью передачи данных на плоттер, 
установите значение оффсета для установленного ножа (в зависимости от угла 
ножа). Затем нажмите кнопку "Start".

ПРИМЕЧАНИЕ: Вы также можете нажать "Сохранить PLT.", Чтобы сохранить файл 
на компьютер, или скопировать его на SD карту или U диск для использования на 
плоттере.

5.6 Резка 5 мм или более 
мелких букв

Для достижения наилучшего качества 
печати, мы предлагаем вам 
использовать узкий лист. Если 
использовать широкий лист, вы должны:
(1) Расположить два прижимных ролика 
как можно ближе к  краям зоны резания.
(2) Убедитесь, что загруженный лист 
размещен по краям с равным 
прижимом.
(3) Установите параметры, как показано 
ниже:

В программе  Flexi:
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5.7 Резка по контуру (опционально) 
(1) Если вы используете эту функцию в первый раз, вы должны 
установить расстояние между красной точкой и стержнем.

(2) Создайте или откройте 
графический файл в Flexi, и 
нажмите кнопку “Effects”-
>”Contour Cut…”, чтобы создать 
контур.

(3) Вы можете настроить параметры  во всплывающем окне "DesignCentral", а  затем 
нажать

В ARTCUT:
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(4) Нажмите 
“Effects”->“Contour

Cut Mark…” для 
ввода знака контур 
среза для 
графического 
файла.

5) Выберете
Point” во 
всплывающем 
окне
“DesignCentral

” и нажмите

(6) Нажмите “File” ->
“Print” для печати 
графического файла.

(7) В окне “Print”, вот некоторые параметры печати для вашего выбора (например, 
если вы хотите распечатать в исходном размере, просто выберите "100см = 1м 
[100%]")
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(8) Загрузите в плотере 
печатный лист и 
нажмите “File” -> “Cut

Contour…”

ВНИМАНИЕ: При загрузке листа, лазерный указатель должен быть 
расположены на правой стороне первой точки, в противном случае плоттер не 
будет работать нормально, зона работы показана ниже:
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(9) В окне “ Cut Contour”
выберете модель вашего 
плоттера и нажмите “ 
Options” tab -> “Edit…” , как 
показано ниже:

(10) В появившемся диалоговом окне, установите параметры Offset X 0.00mm, Offset Y 
0.00mm как показано ниже и нажмите “Apply”-> “OK”.

(11) Затем нажмите “Send”. Во всплывающем диалогом окне “Alignment” в
“Production Manager”, выберете “Interactive alignment (Manual)”,и нажмите “OK”. 

WWW.INTERLASER.RU 39



(12) Необходимо расположить лазерный указатель на первой точке с помощью 
клавишь стрелок или ввести координаты точки вручную и нажать ОК

(13) Следующим появится 
диалоговое окно настройки 
второй точки, лазерный 
указатель автоматически 
переместится ко второй точке. 
При несовпадении укакзтеля и 
точки их указатель подводят 
вручную клавишами стрелками, 
а затем нажимают кнопку "OK ".

(14) Операции для третьей и четвертой точками аналогичны как указано выше.
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(15) Тогда у вас 
появится диалоговое 
окно,  нажмите кнопку 
Origin И затем нажмите 
кнопку "OK", плоттер 
будет вырезать по 
контуру.

5.8 Беспроводное управление (опция)
(1) Вставьте адаптер Bluetooth в порт USB, компьютер 

автоматически установит драйвер вы увидите значок 

Bluetooth на панели задач.

(2) Затем вы сможете найти “Bluetooth Radios” в
Device Manager.

(3) Щелкните правой кнопкой мыши на значок  Bluetooth  на панели задач и нажмите “Open 
Bluetooth Settings”. 

(4) Нажмите “Options” вкладка когда 
всплывающие окна последующих и выберете
“Show the Bluetooth icon in the notification 
area” (галочкой), затем нажмите “Apply”. 

(5) Чтобы добавить устройство, 
пожалуйста, включите плоттер, и 
нажмите“Add” во вкладке “Devices”.
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(6) Выберете “My

device is set up and 

ready to be found” и 
нажмите “Next”.

(7) Добавления устройства 
Bluetooth Device Wizard 
выполняет поиск устройств 
Bluetooth.

(8) Тогда он найдет Teneth 
плоттер ТB, ТB выбрать плоттер, 
и нажмите“Next”.
(9) Мастер спросит, хотите ли 
использовать ключ доступа или 
нет, выберите“ Use the passkey

found in the 
documentation”затем введите 
код доступа в текстовом поле 
(Пароль по умолчанию для ТБ 
серии 1234), затем нажмите 
“Next”.
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(10) Параметры будут настроены и плоттер установлен.... :

(11) При  добавления устройства Bluetooth, пожалуйста, запишите Исходящий порт COM 
(например, исходящий порт COM6), нажмите кнопку «Завершить» (Finish) для 
завершения установки.

(12) После окончания добавления устройства Bluetooth, вы 
можете использовать плоттер Teneth ТB.
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6. Технические условия
Модель

Стенд необязательный (для 720) вертикальная стойка с подачей бумаги

Основная плата 32-разрядный процессор, 4 Мб кэш 

панель управления 11 Мембранные кнопки плюс 2,5 "LED сенсорный экран

тип привода Шаговый / Серво

Максимум ширина 
рабочего поля

Максимум ширина резки 

740 мм / 1300 мм 

630 мм / 1205 мм

Максимальная скорость 
резки 600/1200 мм/с

Maкс. толщина резки 1 мм

Давление ножа 0  -  500 /1000 г (цифровая регулировка)

Механическая 
точность 0.05 мм

отклонение при 
повторе <±0.05 мм

Нож Roland или Pcut совместимые ножи

Шариковый 
стержень

диаметр 11.4 мм , всех типов чернил на водной, глицериновых и этаноловых 
чернил 

Языки команд DM-PL/HP-GL Automatic Identification

Интерфейсы USB / SD card / Serial Port / Wi-Fi / USB disk

Питание AC110В /220В ±10%,50 Гц / 60 Гц

Потребляемая 
мощность < 100 Вт <120 Вт

Рабочие условия температура:+5 - +35,влажность:30%-70%

Размер упаковки 1055*370*335 мм 1595*455*335 мм

Масса 12 кг / 32 кг

Опции Беспроводный интерфейс/Резка по контуру 

R / S 720 - 1300

WWW.INTERLASER.RU 44



ПРИЛОЖЕНИЕ А

    В случае если при подключении USB кабеля компьютер обнаружил новое 
оборудование, но не запустил автоматический поиск и установку драйверов, 
возможна установка  драйвера USB в ручную. Для этого необходимо 
запустить установку драйвера. На диске прилагаемом к оборудованию 
запустите файл находящийся по следующему пути:   FTDI_USB Driver  ->  
Windows  -> CDM20814_Setup

Запустится инсталятор драйвера:

После чего в диспетчере устройств (Компьютер  ->  Свойства  ->  
Оборудование  ->  Диспетчер устройств) во вкладке Порты подключенный 
плоттер определится как показано ниже:

Далее производятся настройки приведенные в главе 5 руководства.
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